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1. Introduction to Kernel for Paradox

Welcome to the user manual for Kernel for Paradox, the most effective and convenient paradox database
recovery software available that recovers data from corrupted .DB paradox database files. This user
manual comprises step by step guidelines on using Kernel for Paradox.

1.1 Using this Manual

This user manual is intended to guide users on using Kernel for Paradox. We suggest that first time users
should read this user manual completely and carefully before proceeding to use the software. However, if
you are an experienced user, you can use the table of contents to find out information pertaining to the
tasks that you need to perform by using Kernel for Paradox.
You can use the table of contents to navigate through different sections of this user manual. The table of
contents lists all the sections that are contained in this user manual in chronological order. The user
manual comprises the following sections:

e Introduction

o Getting Started

e Software Interface

e Repairing Paradox .DB Files

e Full Version

e Support

e Troubleshooting

e Legal Notices

Certain abbreviations have been used throughout this manual. For clear understanding of the contents of
this user manual, please go through the list of abbreviations, mentioned below, before reading the manual.

1.1.1 List of Abbreviations
DB: Database

MS: Microsoft

RAM: Random Access Memory
MB: Mega-Byte

GB: Giga-Byte
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1.2 About Kernel for Paradox

Kernel for Paradox is database repair software for Paradox database files (.DB). This software repairs

corrupt Paradox database files, damaged due to:

Deleted or damaged primary keys or foreign keys
Corrupt or deleted indexes

Lost or deleted predefined defaults, default values
Deleted or damaged tables or table data

Locked .db database file preventing access
Corrupt or damaged multi-volume database files
Damaged or corrupt unique key, indexes

Kernel for Paradox uses quick algorithm for searching and repairing those corrupted database files.

1.3 Salient Features

Salient features of Kernel for Paradox include:

Efficient and embedded with repair algorithms to repair corrupt Paradox databases (.db)
Recovers tables and .db paradox table data
User friendly interface, no technical skills required

Free demo to experience the features and working of the tool before purchasing it

1.4 Who Should Use this Software?

The capability of Kernel for Paradox to repair large sized paradox database (.DB) files makes it
appropriate for use by people, who are striving to deal with corruption in database files. This corruption
could have been caused due to unexpected system shutdown, software crash, deleted or damaged
primary keys or foreign keys, damaged or corrupt unique key indexes, virus attacks etc
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2. Getting Started

Now that you have understood the features and potential of Kernel for Paradox, you are ready to get
hands on experience of the software. To start repairing .DB files, you will first need to download and install
this software.

It is strongly recommended that before installing Kernel for Paradox, you should go through the installation
pre-requisites for the software to ensure that your computer is appropriately configured to run the
software.

2.1 Installation Pre-requisites

The various pre-requisites for installing and running Kernel for Paradox can be broadly classified into two
major categories — Hardware requirements and Software requirements.

2.1.1 Hardware Requirements:

The hardware requirements for installing the software are as follows:
e Pentium Class Processor
e Minimum 64MB RAM (128 MB recommended)
e 10MB for Software installation

e Disk Space - Enough space to store the repaired files

@ You should have at-least 10 MB of free disk space if you want to repair and save a
10 MB .DB file.

2.1.2 Software Requirements:

The software requirements for installing the software can further be grouped into two categories —
Operating system requirements and Paradox version requirements. The requirements are as follows:

2.1.2.1 Operating System Requirements
Supported Operating Systems:

e Windows Vista

e Windows XP

e Windows 2003

e Windows 2000

e Windows Me
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e Windows 98
2.1.2.2 Paradox Version Requirements
Supported Paradox versions:

e 3.0,35,4.0,45,5,6,7,9 and 10 Paradox databases.
2.2 Downloading Kernel for Paradox for the First Time

After checking your computer with the prescribed system requirements for Kernel for Paradox, you can
download and install the software on your computer. You can buy the full version of the software from any
one of our authorized resellers — Element5, Asknet and 2CO.

If you want to try using Kernel for Paradox before buying it, you can download the evaluation version from
the following link:

http://www.nucleustechnologies.com/Download-Paradox-Database-Repair-Software.php

@ You can repair paradox database files saved on your system by using the evaluation
version of Kernel for Paradox; however, the repaired file will not be saved until you
purchase full version of the software.

2.3 Install Kernel for Paradox

After downloading the installer file for Kernel for Paradox, you can install the software by running the file.
To install Kernel for Paradox:

1. Double-click the Kernel for Paradox installer. Follow the on-screen instructions.
The Setup Installation Complete screen will be displayed.

2. Click Finish to launch the software.

2.4 Start Kernel for Paradox

To start Kernel for Paradox:
Click the Start A All Programs A Kernel for Paradox

Alternatively, you can launch Kernel for Paradox by double-clicking the shortcut icon available on the
Desktop and Quick Launch icon.

2.5 Uninstall Kernel for Paradox

You may need to uninstall Kernel for Paradox. To uninstall Kernel for Paradox:
1. Click the Start A All Programs A Kernel for Paradox A Uninstall Kernel for Paradox

A warning message will be displayed.

Kernel ee

©Nucleus Data Recovery.Com Private Limited for Patadox


http://www.nucleustechnologies.com/Download-Paradox-Database-Repair-Software.php

2. Click ‘Yes’ to uninstall Kernel for Paradox.

@ Before proceeding to uninstall Kernel for Paradox, you must ensure that the software
is not running in the system background.

You can alternatively uninstall Kernel for Paradox from the Control Panel by performing the following
steps:

1. Click the Start Menu A Control Panel and then double click the Add or Remove Programs icon.
2. Select Kernel for Paradox and click Remove. A warning message will be displayed.

3. Click ‘Yes’ to uninstall Kernel for Paradox.
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3. Software Interface

Now that Kernel for Paradox has been installed on your computer, you can start using the software after
getting acquainted with the software interface.

3.1 Menu-bar

The menu-bar of Kernel for Paradox comprises three main menus — File, Tools, and Help.

3.1.1 File Menu

The File menu comprises four menu items.

File | Tools Help

ga  AddFiles..

x Remove Al Files

@ Femove Selected Files

38 Ei

Figure 3.1: File Menu

Menu items in the File menu:

Add Files Select to add corrupt DB file(s)

Remove All Select to remove all file(s) from the list

Files

Remove Select to remove selected file(s) from the list

Selected Files

Exit Select to close the software

3.1.2 Tools Menu

The Tools menu comprises two menu items.
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Tu:u:ulsi Help
fq} Setting
(g) Liveupdate

Figure 3.2: Tools Menu

Menu Items in the Tools menu:

Setting Select to configure file name prefix

Select to update current software with the latest

Liveupdate
version available

3.1.3 Help Menu

The Help menu comprises three menu items.

Help i
ﬁ Help

¥ About Mucleus Kemel Paradox...
@ Software Home Page. ..

Figure 3.3: Help Menu

Menu items in the Help menu:

Select to view User Guide of software

Help
About Nucleus Kernel Select to view version-related and support information of
Paradox Kernel for Paradox
Software Home Page... Select to visit the software homepage
3.2 Tool-bar

The tool-bar in Kernel for Paradox is displayed below the menu-bar. The tool-bar provides a convenient
and user-friendly method to perform certain actions that can also be performed by using the menu-bar.
Read the information in the table below to find out about the tool-bar buttons:
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@ Add Files Select to add corrupt DB file(s)
Add Files

[ffi Repair Files Select to repair the listed file(s)
REE Files

l ! Save Files Select to save the repaired file(s)

Save Files

) Settings Select to change the prefix of the repaired file
Im name
Settings
. Live-Update Select to update current software with the latest
@ version available
Live-Update
2 Buy Online Select to buy the software online
Buy Online

3.3 Status Bar

Status bar is displayed at the bottom of the softw
bar if Kernel for Paradoxi s ready to be used. Status bar also di
respectively correspond to the Caps Lock, Num Lock, and Scroll Lock keys on your keyboard. If any of

these keys are pressed, the color of the corresponding text will turn black.

[reacy cap oM scre |

Figure 3.4: Status Bar
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3.4 Buttons Used

Apart from the standard options available in menu-bar and tool-bar, following are the main buttons
displayed on the respective window(s).

Click to remove all files from the list

Click to remove selected files from the list

Click to start the repairing process

Click to go to the main window

© O & E
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4. Repairing Paradox .DB Files

Now that you have complete familiarity of the user interface of Kernel for Paradox, you are ready to repair
.DB files. To repair .DB files:

1. Launch Kernel for Paradox.

% Nucleus Kernel - Paradox

Fie Todk Hep
5 .
2 & B 5 @ Kernel
Add Files  Repair Files  Save Files Settings  Live-Update Paradox
@ 1. Add files mto kst from the add fils button from toofbar
2. Click next or repaar file button
. B
L) Fie Name | P Location ) FleSes ) CrestionTime 4] Last Access Ti.. [] LastwritenTime | 7| Fis Type
< »
Ready [Ll

Figure 4.1: Main Window

=

2. Select the corrupt file(s) from Add Files [addFiles | button or click Files A Add Files.
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% Mucleus Kernel - Paradox

Ele Tosh Hep

2 & E B

05-12-2005 12:00 AM

[ ) Kernel
AddFiles  Repair Files SaveFiles  Settings  Live-Update Paradox
1. Add files mio bist from the add file button from toolbar
2. Chek next or repair file button
Qo
[ Féenams [ Fie Location ) Flesus ) CrestionTime ] LastaccessTi.. ] LastwettenTime | ] FleType
[ (8] Copy of tentk. DB C:\Documents and SettingsissrvendralDesit... 409 06-12-2005 10:57 &M 06-12-2005 120048 20-11-200501:11 PM Diska Blase File
(] (Bl Copy of vardor.., Cr\Dotuments and SeltingiissrvendraiDett.., 6144 05-12-2005 10:57 AM  (5-12-2005 12:00 AM  06-12-2005 I 1:08AM  Data Base Fie
[ (&) eerer.06 Co\Documnents and SettingsiesrvendraiDest... 409 05-12-2005 10:45 AM  (5-12-2005 1Z:00 AM  29-11-200501:11PM Diska Base Fie
B (& verdors.do C\Docunents and SettingsissrvendraiDesit.., 6144 05-12-2005 10:57 AM

06-12-2005 11:09 AWM Dhak s Busn Filer

Ready

@

Lt

Figure 4.2: Added DB Files

button.

@ You can select multiple .DB files to repair them in one repair cycle. You can remove
any file from the list by selecting the file from the list and clicking Remove Files

3. Click Next eto start with .DB file repairing process or select Repair Files

&

Repair Files | hytton.

Kernel for Paradox starts the file repairing process and shows you the details of the corrupted file(s).
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'3 ": Nucleus Kernel - Paradox

fie  Toos Help

2 & B & @ Kernel

Add Files  Repair Files = Save Files  Settings  Live-Update

B 0T P s T e IYwmsmmewnfmﬂubymhcmmmm
2 You can save the save bulion on tookbar

=

Repair Progress...
Analyzing Header
Error found in Header
Repairing Header
Extracting data
Adding data
Repair Complete
Please select the file from the list below, and Double Click to see the preview of save using "Save Files" from toalbar

Fie Mame
© C:\Documents and SettingslservendralDesktopidb Fkes\Copy of bentit, 08
O Cipn and wirslDesktopid Fle\Copy of vendors.db
O CH\Decuments and Settings| servendralDeskbopdb flesitenti D

@ Ci L5 el Sadtings db Flashvandos.db

SRR

Figure 4.3: Details of Files

4. Get preview of the repaired files by double clicking the file(s) in the list.
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Figure 4.4: Preview

=
.—_i"‘,
5. Click Save Files |saveFiles | to save the repaired files at the desired location.

@ By default, names of the repaired .DB files will be the original file name prefixed by
t he t e’ xHoweveR gop can change the prefix by clicking the Settings button in
the toolbar.
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5. Full Version

Although you can use Kernel for Paradox evaluation version for free and experience the working of the
software, there are certain features that are not available in the evaluation version.

5.1 Requirement of Full Version

By using the evaluation version of Kernel for Paradox, you can repair corrupt Paradox database files;
however, you cannot save the repaired files with recovered data.

You will need to buy full version of the software to save the recovered results.

5.2 Purchasing Full Version

You can buy the full version of Kernel for Paradox from any one of our authorized resellers — Element5,
Asknet and 2CO.

As soon the purchase transaction with our resellers gets completed, our sales team will send you an email
comprising the URL to download the full version of Kernel for Paradox and activation details of the
software.
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6. Support

We have an extensive and efficient support system in place to assist our customers with all issues related
to using Kernel for Paradox. The software comes with an embedded help manual that can be accessed by
clicking HelpA Help in the menu-bar. You can also press the F1 key on the keyboard of your computer to
access the embedded help of Kernel for Paradox.

You can access the online help for Kernel for Paradox at http://www.nucleustechnologies.com/Online-
Helps.html

View Animated Working demo of the software at
http://www.nucleustechnologies.com/Animated Paradox Database Recovery.html

We also have live support wherein you can chat with our software experts at
http://www.nucleustechnologies.com/Support.html

To talk on phone with our software experts call:

Help line:

+91-9818725861
1-866-348-7872 (Toll Free for USA/CANADA)
You can also email us about your queries at;

sales@nucleustechnologies.com for Sales

support@nucleustechnologies.com for Support

contact@nucleustechnologies.com for General Queries
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/. Troubleshooting

This section deals with your generic and specific queries pertaining to using Kernel for Paradox.

7.1 Common Issues

Why does Kernel for Paradox have limitations in evaluation copy?

The free evaluation version of Kernel for Paradox is intended to enable you to experience the capabilities
of the software. You will need to buy the software for saving the recovered data.

7.2 Frequently Asked Questions

How to Buy Kernel for Paradox?

You can buy Kernel for Paradox online at http://www.nucleustechnologies.com/Buy-Paradox-Database-
Repair-Software.php

| have lost my full version for Kernel for Paradox. Can you help me?

Please email us at sales@nucleustechnologies.com. Please include your name, address, email address,
and order confirmation number (if you have it). We will be happy to help you.
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8. Legal Notices

This section comprises the legal specification about Kernel for Paradox and the company NUCLEUS
DATA RECOVERY.COM PRIVATE LIMITED

8.1 Copyright

NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED, Nucleus Kernel accompanied user manual and
documentation are copyright of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED, with all rights
reserved. Under the copyright laws, this user manual cannot be reproduced in any form without the prior
written permission of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. No Patent Liability is
assumed, however, with respect to the use of the information contained herein.

© NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. All rights reserved.
8.2 Trademark

Nucleus Kernel ® is a copyright work of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED
Windows 95®, Windows 98®, Windows ME®, Windows NT®, Windows 2000 Server®, Windows 2000
Advanced Server®, Windows 2003 Server®, Windows XP®, MS-DOS and Paradox are registered
trademarks of Microsoft Corporation and Corel Corporation respectively.

All other brand and product names are trademarks or registered trademarks of their respective companies.

8.3 Disclaimer

The Information contained in this manual, including but not limited to any product specifications, is subject
to change without notice. NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED provides no warranty
with regard to this manual or any other information contained herein and here by expressly disclaims any
implied warranties of merchantability or fithess for any particular purpose with regard to any of the
foregoing NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED assumes no liability for any damages
incurred directly or indirectly from any technical or typographical errors or omissions contained herein or
for discrepancies between the product and the manual. In no event shall NUCLEUS DATA
RECOVERY.COM PRIVATE LIMITED, be liable for any incidental, consequential special, or exemplary
damages, whether based on tort, contract or otherwise, arising out of or in connection with this manual or
any other information contained herein or the use there of.

8.4 License Agreement

Nucleus Kernel PARADOX Copyright © by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED
Your Agreement to this License

You should carefully read the following terms and conditions before using, installing or distributing this
software, unless you have a different license agreement signed by NUCLEUS DATA RECOVERY.COM
PRIVATE LIMITED. The terms and conditions of this License describe the permitted use and users of
each Licensed Copy of Nucleus Kernel PARADOX. For purposes of this License, if you have a valid
license, you have the right to use a single Licensed Copy of Nucleus Kernel.
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Scope of License

Each Licensed Copy of Nucleus Kernel may either be used by a single person or used non-simultaneously
by multiple people who use the software personally installed on a single workstation.

All rights of any kind in Nucleus Kernel, which are not expressly granted in this License, are entirely and
exclusively reserved to and by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. You may not rent,
lease, modify, translate, reverse engineer, decompile, disassemble, or create derivative works based on,
Nucleus Kernel, nor permit anyone else to do so. You may not make access to Nucleus Kernel available
to others in connection with a service bureau, application service provider, or similar business, nor permit
anyone else to do so.

Warranty Disclaimers and Liability Limitations

Nucleus Kernel, and any and all accompanying software, files, data and materials, are distributed and
provided as is and with no warranties of any kind, whether expressed or implied. In particular, there is no
warranty for the quality of data recovered. You acknowledge that good data processing procedure dictates
that any program, including Nucleus Kernel, must be thoroughly tested with non-critical data before there
is any reliance on it, and you hereby assume the entire risk of all use of the copies of Nucleus Kernel
covered by this License. This disclaimer of warranty constitutes an essential part of this License.

In addition, in no event does NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED authorize you or
anyone else to use Nucleus Kernel in applications or systems where Nucleus Kernel failure to perform can
reasonably be expected to result in a significant physical injury, or in loss of life. Any such use is entirely at
your own risk, and you agree to hold NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED harmless
from any and all claims or losses relating to such unauthorized use.

General

This License is the complete statement of the agreement between the parties on the subject matter, and
merges and supersedes all other or prior understandings, purchase orders, agreements and
arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction and
venue for all matters relating to this License shall be in courts and for a located in the State of Delhi, and
you consent to such jurisdiction and venue. There are no third party beneficiaries of any promises,
obligations or representations made by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED herein.
Any waiver by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED of any violation of this License by
you shall not constitute, nor contribute to, a waiver by NUCLEUS DATA RECOVERY.COM PRIVATE
LIMITED of any other or future violation of the same provision, or any other provision, of this License.
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